
NEWT and SNMP Contents

This help file contains a list of all Help topics available for NEWT and SNMP.    You can use the scroll bar 
to see the entries that are not currently visible in the Help window.    For information on how to use Help, 
press F1 or choose Using Help from the Help menu.
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Overview

When you use any Chameleon application, an icon representing the NEWT TCP/IP kernel appears on the 
screen.    The NEWT application permits you to view information about the current network interfaces.    
The NEWT application must be running for network connectivity to be enabled.    It cannot be terminated 
explicitly, but exits automatically when the last Chameleon application exits.    NEWT provides information 
through a set of dialog boxes which you can display by choosing the NEWT icon.

Note: You can minimize the NEWT application with many open dialog boxes and it will minimize all the 
dialog boxes as well.    When the NEWT application is restored, all dialog boxes reappear as they 
were prior to being minimized.

See Also:

Network Statistics

Network Tables



Network Statistics

The Statistics menu consists of selections for all network protocol layers (Interface, ARP, IP, ICMP, UDP, 
TCP and SNMP.

The Interface statistics are displayed for the currently selected interface.    Double-clicking on a particular 
interface entry also displays the Interface statistics dialog box.

Each menu selection displays a dialog box with statistic values for that protocol.    Each of these dialog 
boxes can be set to update values every second, by pressing the Start button.    Further updates can be 
prevented by pressing the Stop button (which appears after you have pressed the Start button).    The 
Reset button can be used at any time to reset the statistics values to zero for that window.



Network Tables

The Tables menu consists of selections for all network protocol tables (ARP, route, socket, Gateway and 
DNS, and SNMP).

· The ARP table displays the current mapping of IP addresses to physical addresses and any defined 
Frequent Destinations.

· The Route table displays the current set of route entries corresponding to all local interfaces, static 
route entries, and the default gateway, if specified.

· The Socket table displays the currently open sockets, as well as their connections and states.    There 
is always at least one socket entry used by the NEWT application.

· The Gateway and DNS table provides a view of the current default gateway, as well as the DNS 
(Domain Name Server) IP addresses.    The default gateway specifies the machine that will accept 
and route packets destined for other networks. The IP address of a DNS and up to two alternatives 
may be specified.

· The SNMP table provides a view of currently active agents with their corresponding Enterprise ID.    
The Enterprise ID is a unique identification number given by the Internet registration to organizations 
who request an ID for purposes of defining SNMP MIBs.    This is done to ensure the uniqueness of all 
managed objects for SNMP.    NETMANAGE's Enterprise ID is 233.



Interface

Interface provides information about the selected interface.    To view the information, select first a specific 
interface by pointing to the interface list and clicking the mouse.

To view information about an Interface:

1. Choose the Interface... command from the Statistics menu.

2. Choose the Start button to begin automatic updating of information.

3. Choose the Stop button to stop the updating.

4. Choose the Reset button to reset the counters.



ARP

ARP provides statistical information about the ARP activity.

To view ARP related statistics:

1. Choose the ARP... command from the Statistics menu.

2. Choose the Start button to begin automatic updating of information.

3. Choose the Stop button to stop the updating.

4. Choose the Reset button to reset the counters.



IP

IP provides statistical information about the IP activity.

To view IP related statistics:

1. Choose the IP... command from the Statistics menu.

2. Choose the Start button to begin automatic updating of information.

3. Choose the Stop button to stop the updating.

4. Choose the Reset button to reset the counters.



ICMP

ICMP provides statistical information about the ICMP activity.

To view ICMP related statistics:

1. Choose the ICMP... command from the Statistics menu.

2. Choose the Start button to begin automatic updating of information.

3. Choose the Stop button to stop the updating.

4. Choose the Reset button to reset the counters.



UDP

UDP provides statistical information about the UDP activity.

To view UDP related statistics:

1. Choose the UDP... command from the Statistics menu.

2. Choose the Start button to begin automatic updating of information.

3. Choose the Stop button to stop the updating.

4. Choose the Reset button to reset the counters.



TCP

TCP provides statistical information about the TCP activity.

To view TCP related statistics:

1. Choose the TCP... command from the Statistics menu.

2. Choose the Start button to begin automatic updating of information.

3. Choose the Stop button to stop the updating.

4. Choose the Reset button to reset the counters.



SNMP

The SNMP selection presents Statistics for the SNMP protocol layer. 

To view and update values:

1. Choose the SNMP... command from the Statistics menu.

2. To update values every second of the SNMP protocol layer, choose the Start button.

3. Choose the Stop button to stop updating values.

4. Choose the Reset button to reset statistic values to zero for that window.



ARP...

ARP provides a view of the current ARP table in the stack.    This information can be used to diagnose 
communication problems in the network.

To display the ARP table:

Choose the ARP... command from the Tables menu.



Route...

Route provides a view of the current Route table in the stack.    This information can be used to diagnose 
communication problems in the network.

To display the Route table:

Choose the Route... command from the Tables menu.



Socket...

SOCKET provides a view of the current open sockets, as well as their connections and states.    There is 
at least one socket entry used by the NEWT application.

To display the Socket table:

Choose the Socket... command from the Tables menu.



Gateway and DNS...

Gateway and DNS provides a view of the current default gateway, as well as the DNS ( Domain Name 
Server ) IP addresses. The IP address of a DNS and up to two alternatives may be specified.    The 
default gateway specifies which router will be responsible for letting one subnet talk to any other indirectly 
connected subnet.

To display the Gateway and DNS:

Choose the Gateway and DNS... command from the Tables menu.



SNMP...

The SNMP table provides a view of currently active agents with their corresponding Enterprise ID.    The 
Enterprise ID is a unique identification number given by the Internet registration to organizations who 
request an ID for purposes of defining SNMP MIBs.    This is done to ensure the uniqueness of all 
managed objects for SNMP.    NetManage's Enterprise ID is 233.



DLLs...

The DLLs table provides a view of Dlls loaded by the NetManage stack.    Handle information is provided 
for debugging purposes.



Host Administration...

In order to personalize your workstation, you need to enter information that describes it.    This information 
is part of the "system" group of MIB-II, and includes the following:

· your name

· administrative contact regarding this workstation

· location where the workstation resides

To enter Host administration information, do the following:

1. Choose the Host Administration...command from the SNMP menu.

2. Enter your name, the name of an administrative contact for this workstation, and the location where 
the workstation resides. 

3. If desired, select the Generate Traps option, and choose the OK button.

This information will be available for management stations that support the MIB-II.



Trusted Managers...

The Trusted Managers option allows you to assign special permissions to an SNMP manager.    Special 
permissions include, for example, the ability to launch applications.

1. Choose the Trusted Managers... command from the SNMP menu.

2. Enter the node IP address or name from the list of SNMP managers provided in the field.

3. Choose the OK button.



Trap Administration...

The Trap administration option allows you to determine which destinations receive notification from an 
SNMP agent.    To enter Trap Administration information, do the following:

1. Choose the Trap Administration... command from the SNMP menu.

2. Enter the default destination to where SNMP agent notification will be sent.

3. If desired, select additional preferences and choose the OK button.



Community...

The Community... option allows you to enter the community string you want to apply to the Get and Set 
receipt operations.    When you do not enter community field information, the community is not checked 
and any message is accepted.    To enter Community information, do the following:

1. Choose the Community... command from the SNMP menu.

2. Enter the a string you want to apply in the Get and Set fields.

Many systems use a community of "public" for Get and "private" for Set.    Note that the text you enter 
in each field is case sensitive and your selections are saved encrypted in the configuration file.

1. Choose the OK button.

This personalized information is now included in the administration portion of the MIB-II in your agent.



Agents

All agents start automatically as soon you start a NetManage application:

Agents included are:

DOS

MIBII

SNMP Daemon

Software Distribution and Backup

Workstation

Windows



DOS

The DOS Group is defined under the NetManage Enterprise (=233).

It is defined as Object-Id = Netmanage.3 and includes the following objects:

- Current Drive (OID=Dos.1)

Returns the "Current Drive" in use at your machine, with 1=A, 2=B, etc.

- DOS memory size (OID=Dos.2)

Returns DOS base memory size in K-bytes (typically 640)



MIBII

Groups supported include:

· System Group

· Interface Group

· Address Translation Table Group

· IP Group

· ICMP Group

· TCP Group

· UDP Group

Current support is to RFC 1213.    Except the EGP Group and the Transmissions Group.



SNMP Daemon

The SNMP Daemon Group is defined under the NetManage Enterprise (=233). It is defined as Object-Id = 
NetManage.1. It provides information about the agents that are currently registered with the daemon. Its 
structure is a table (OID=snmpd.1). Each entry in the table (OID=snmpd.1.1) is indexed by the Enterprise-
OID of the agent, and consists of the following information:

agentEnterprise (OID=entry.1)

The Enterprise-ID (sub-tree) for which the agent is registered. (OBJECT IDENTIFIER)

agentWindow (OID=entry.2)

Returns the window handle of the agent's process (INTEGER).

agentDescription (OID=entry.3)

Returns a DisplayString with the agent's description.



Software Distribution and Backup

The Software Distribution agent allows the network to distribute software, which is sent by a NEWTWatch 
manager, to the current machine.

The Backup agent is controlled by the NEWTWatch Backup application.    It runs in the background and 
moves files from the local machine to a server.    When the agent is running, an automated icon appears 
that shows moving files.



Workstation

The Workstation Group (ws) is defined under the NetManage Enterprise (=233). It is defined as Object-Id = Netmanage.2 and 
includes the following objects:

wsCPU (OID=ws.1)

Returns (Display String) the workstation CPU type (e.g., 386)

wsComputerType (OID=ws.2)

Returns (Display String) the workstation Computer Type (e.g., PC/AT).

wsModel (OID=ws.3)

Returns (INTEGER) model number.

wsSubmodel (OID=ws.4)

Returns (INTEGER) submodel number.

wsBiosVersion (OID=ws.5)

Returns (INTEGER) the Bios version.

wsOS (OID=ws.6)

Returns (DisplayString) the operating system name (e.g., MS-DOS)

wsOSMajVersion (OID=ws.7)

Returns (INTEGER) the operating system major version number (e.g., "5" for DOS 5.0)

wsOSMinVersion (OID=ws.8)

Returns (INTEGER) the operating system minor version number (e.g., "0" for DOS 5.0)

wsNDIStable (OID=ws.9). 

====================

This is a table which describes the different adapter cards that reside inside the workstation. The table is indexed by the physical 
address of the entries. The structure of each entry (OID=ws.9.1) consists of the following information:

wsPermPhysAddr (OID=entry.1)

Return the permanent address of the adapter (PhysAddress)

wsCurrPhysAddr (OID=entry.2)

Returns the current address assigned    to the adapter (not always equal to the "permanent address". Some communications 
packages, such as Decnet, change it) (type is PhysAddress)

wsDescription (OID=entry.3)

Return a DisplayString that describes the adapter.



wsModuleName (OID=entry.4)

Returns a DisplayString that describes the module name.

wsMACType (OID=entry.5)

Returns a DisplayString describing the MAC used by the adapter.

wsIEEECode (OID=entry.6)

Returns (Octet) the IEEE code assigned to the

manufacturer of the adapter.

wsIRQ (OID=entry.7)

Returns (INTEGER) the interrupt line used by the adapter.

wsFrameSize (OID=entry.8)

Returns (INTEGER) the Frame Size used by the adapter.

wsTXCapacity (OID=entry.9)

Returns (INTEGER) the Transmit Buffer capacity of the adapter.

=========(end of NDIS table definition)==============

wsMathCoprocessor (OID=ws.10)

Returns 1 if math co-processor exists, 0 otherwise.

wsFloppyDrives (OID=ws.11)

Returns the number of floppy drives defined for the workstation.

wsRS232Ports (OID=ws.12)

Returns the number of serial ports defined for the workstation)



Windows mib

The Windows Group is defined under the NetManage Enterprise ID (=233)

It is defined as Object-Id = Netmanage.4 and includes the following objects:

Windows Version (OID=Windows.1)

Returns a string showing the Windows version number of your PC

Memory Above (OID=Windows.2)

Returns the amount of memory (in bytes) available above the EMS bankline (refer to "Windows guide to Programming" for 
more information).

Memory Below (OID=Windows.3)

Returns the amount of memory (in bytes) available below the EMS bankline (refer to "Windows guide to Programming" for 
more information).

Windows Flags (OID=Windows.4)

Returns the Windows' configuration flags on your PC. (refer to the Windows manual for bit interpretation)

windows task table (OID=windows.5)

============================

This is a table which describes the tasks (applications) that are currently running at the workstation. The table is indexed by the 
window handler of the task. This list is the same as the one you'll see in Window's "Task List" (double-click anywhere on the 
background to see the task-list). The structure of each entry (OID=windows.5.1) consists of the following information:

winHandle (OID=entry.1)

Returns (INTEGER) the window handle of the task (meaningful only to programmers)

winStyle (OID=entry.2)

Returns (INTEGER) the window style (a bit mask of different attributes, meaningful only to programmers)

winClass (OID=entry.3)

Returns a DisplayString that describes the class of the task.

winTitle (OID=entry.4)

Returns (DisplayString) the title (name) of the task (e.g., "program Manager", "ping-Unix", etc.)

winModule (OID=entry.5)

Returns (DisplayString) with the task module (typically the command that started it, e.g., c:\netmanag\ping.exe)



Contents

Using Help

To choose a Help topic:

Mouse Point to the underlined topic you want to view and click the mouse button. When the 
pointer is over an item you can choose, the pointer changes to a hand icon.

Keyboard Press Tab to move the highlight to the underlined topic you want to view, and then 
press Enter.

To exit Help:

Mouse 1:    Point to the File menu and click the mouse button.

2:    Click the Exit command.

Keyboard 1:    Press Alt.

2:    Type the letter F.

About NEWT...

Choose the About NEWT... command from the Help menu for information about this program.

Choose the Copy button to copy the application version information into the Windows Clipboard.    You 
can then paste this information into any application.

Choose the OK button to continue.

 




